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1 Setting Up Sibelius 6
for the First Time

Essential Tips for Chapter 1

1. When setting up Sibelius for the first time, all of your MIDI input and
output devices must be set up first. (MIDI devices are now in Sibelius >
Preferences > Input Devices, unlike in older versions of the program.)

2. Sibelius 6 relies on virtual instruments for playback through a new system
called Sibelius Sounds Essentials (SSE). To hear your work, make sure SSE
is installed from the installation DVD.

3. The Quick Start menu provides easy access to Sibelius functions, such as
starting new scores, importing MIDI files, or scanning music.

4. The Create drop-down menu is the central hub for creating objects in
your Sibelius score; check out its contents.

5. The toolbar contains shortcuts to the most used functions in Sibelius. You
can hover your mouse over any button, and Sibelius will share a tool tip
that lets you know what the currently selected button does.
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W
hen you’re installed and ready to roll, you need to start the process of get-

ting Sibelius set up for your own personal working style. To begin with,

you’ll set up the following parameters within Sibelius:

n Detecting and activating your external MIDI instruments/interfaces

n Activating the Sibelius Sounds Essentials plug-in

n Fine-tuning the audio system options for your computer

These essential tasks only need to be set up the first time you run Sibelius. As long as

you don’t change your working style too much, these settings will remain intact for as

long as you run Sibelius. Thankfully, they’re not hard to change at any point, if you

should need to.

An important note: We’re going to dive into these parts of the program first to ensure

that as soon as you truly enter the world of Sibelius, things simply “work” for you

(scores play back, your soundcard is found, your MIDI input device works as expected,

and so on). To do this, I have to jump around to a few different parts of the program

before I actually explain the interface or why you’re doing what you’re doing. Have no

fear! We will cover each of these elements again in more detail. For now, I want to

simply get Sibelius working for you so that when you take your first steps with the

program, you’ll get all you expect. Sound good?

Windows and Mac Sibelius is a cross-platform application, which means that it

runs on Windows- or Mac-based computers. More importantly, Sibelius looks

remarkably similar when running on Windows or Mac. The only obvious differ-

ences are in the key commands. On the Mac, the Command key is used instead

of the Ctrl key on a Windows keyboard. Because these keyboard shortcuts will

run throughout the book, I will list shortcuts for Windows first, followed by the

equivalent Mac shortcut.

Files created on the Windows version of Sibelius can be opened on the

Mac version of Sibelius and vice versa. More often than not, if you

simply substitute the Command key for the Ctrl key when using Sibelius on a

Mac (or vice versa when using a Windows PC), you should find almost

everything else the same. Any differences will be clearly pointed out throughout

the text.

Starting Sibelius

Once Sibelius has been launched and successfully registered, you will come to the

Quick Start dialog box shown in Figure 1.1.
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The Quick Start dialog box provides you with a portal into the most commonly used

tasks when you start Sibelius. These tasks include:

n Opening a recent file

n Opening another file

n Starting a new score

n Browsing teaching resources and worksheets

n Opening a MIDI file

n Scanning in printed music with PhotoScore

n Transcribing music with AudioScore

All of the items in the Quick Start dialog box are there to speed up your entry into any

Sibelius score by consolidating the most frequently used commands into one screen.

You can gain access to any of the functions in the Quick Start dialog box from the

drop-down menus across the top of the Sibelius window as well.

For now, close the Quick Start dialog box by clicking once on the Cancel button. Don’t

worry; we’ll come back to the Quick Start dialog box. But now you’re ready to start

setting up Sibelius for your own personal needs.

Figure 1.1 Sibelius’s Quick Start dialog box.
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Activating MIDI Input Devices

Sibelius communicates with external MIDI input devices (such as keyboards or guitar

synths) for its note input. Although you can input notes into Sibelius with a combina-

tion of mouse clicks and computer keyboard entries, many users still enter notes using a

MIDI keyboard. To set up Sibelius to communicate with your external MIDI sources,

you need to set up the input device preferences.

Changed in Sibelius 6 If you are used to using Sibelius 1 through 4, it’s worth

noting that the way you set up your input devices has changed as of version 5. In

previous versions, input devices were managed through the consolidated Play-

back and Input Devices menu. Sibelius has moved the input device setup to the

Sibelius Preferences dialog box.

You first need to access the Preferences dialog box within Sibelius, which you can find

in Windows by choosing Preference from the File menu or by using the key command

Ctrlþ, (comma). On a Mac, you will find it by choosing Preference from the Sibelius 6

menu or by using the key command Commandþ, (comma). Figure 1.2 shows the

default Preferences dialog box.

Figure 1.2 Sibelius’s Preferences dialog box.
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As you can see, Sibelius has a lot of preferences you can set. The window is divided into

two sides: The left side has a list of categories, while the right side shows you all the

preferences for the selected category. To access your MIDI devices, on the left side,

scroll down to Input Devices and highlight it to bring up its preferences. Figure 1.3

shows the Input Devices Preferences dialog box.

This dialog box is the control window for any external MIDI devices you may have

attached to your system. Any MIDI devices that are installed on your computer will

show up in this menu, and you can activate them, tell Sibelius what types of devices

they are, and define the input map (which maps extra controllers, such as knobs and

sliders if your keyboard has them, to different mixer and playback functions within

Sibelius).

Driver Setup Sibelius will detect only MIDI devices that are already installed and

working on your system. This typically involves the installation of a driver of

some sort that enables your device to function within the operating system.

Please check with the documentation that came with your MIDI device for

instructions on how to install it in your system. Remember, Sibelius will manage

and see only devices that are already installed on your system. The exception is a

Figure 1.3 Input Devices Preferences dialog box.
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class-compliant device that does not require a driver to function. Your product’s

documentation will tell you whether your device needs a driver. Sibelius can’t

install a driver file for you. Youwill always need to do this through your operating

system. The best way to ensure that you have an up-to-date driver is to down-

load one from the manufacturer’s website.

Installed devices will automatically appear on the list on the right side of the window.

To enable a device for use with Sibelius, you must check the Use column directly to the

right of the name of the device. When you’ve done that, tap a few keys on your MIDI

device to see whether it’s working. If everything is working, the Test indicator will light

up with a green activity meter to signify a successful connection.

Next to the name of your device, you will see a column for Type, which sets the type of

MIDI device you’re using. There is a limited number of choices: Keyboard or Guitar.

Unless you’re one of the brave few who use a MIDI guitar input device, choose Key-

board (which is the default anyway).

If you are using a MIDI guitar, choosing Guitar in the Type column will activate the

guitar-specific MIDI Guitar Channels, which will make note entry with a guitar much

easier. In the lower-left corner, simply choose how many strings your guitar has and

specify which MIDI channel your first (highest pitched) string is. On all current Roland

and AXON guitar-to-MIDI converters, the default is Channel 1. Setting up your guitar

this way will enable Sibelius to automatically create tablature at the correct location on

the guitar’s neck when using a guitar-to-MIDI converter.

The last column in the Input Devices dialog box is the Input Map column, which is

useful if your MIDI controller has an array of knobs and sliders for controlling func-

tions in Sibelius (playback, mixer levels). The default “keyboard” should work for you,

but if you see the model of your device listed in the Input Map drop-down menu (which

is seen when you click on the word Keyboard), please choose it to enable that function-

ality on your device.

The MIDI Thru check box should be enabled (checked) only if your MIDI keyboard

has no built-in sounds. Switch it off if your input device has its own sounds that you

prefer to use over SSE.

The last preference is whether to engage low-latency MIDI input. Most MIDI inputs

have a short delay, or latency, and this check box is useful in combating that when

you’re playing live into Sibelius using Flexi-time, Sibelius’s real-time note input method

(detailed in Chapter 2, “Note Entry”).

Figure 1.4 shows an example screen, fully set up for a Korg nanoKEY MIDI controller

keyboard. Because this keyboard is a controller (thus, it makes no sound of its own), I

made sure to select MIDI Thru for that device.
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The good news is that you’re finished setting up MIDI devices (unless you buy a new

one). It only takes a few minutes, but it’s well worth the time to get Sibelius talking

properly to your devices.

Activating Sibelius Sounds Essentials

One of the major new features in Sibelius 6 is its new sound player. If you’re not inter-

ested in playback (you just want to score music), then you can skip this entire section.

The included playback engine (new in Sibelius 6) is Sibelius Player with Sibelius Sounds

Essentials. SSE is collection of samples from leading sample manufacturers that guar-

antees you the most realistic playback from Sibelius.

You’ll want to set up Sibelius to play back through this new system. To do so, in

the top Sibelius menu bar, select Playback Devices from the Play menu. (The procedure

is the same in both Mac and Windows.) This will bring you to the screen shown in

Figure 1.5, the Playback Devices window.

Install It! Sibelius Sounds Essentials is not installed by default. You have to

install it from a separate installer on your installation DVD. If you can’t find

the Sibelius Player in your devices list, check and see whether you’ve installed

the SSE library.

Figure 1.4 A completed Input Devices dialog box.
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The Playback Devices window is a two-part window that configures how Sibelius plays

back to its included Sibelius Player, your third-party VST/AU plug-ins, or external

hardware. The window is fairly extensive, and we will cover it in more detail later in

the book. For now, you are going to activate Sibelius Sounds Essentials. To do so, in

your Playback Devices window, find the Configuration menu and select Sibelius

Sounds from it. Doing so will automatically activate Sibelius Player as the device

and Essentials as the sound set.

Once that’s finished, you can close the window, and Sibelius will automatically play

back your scores using the new Sibelius Player.

Virtual Instruments You may choose to use additional third-party sound libra-

ries to expand your sound palette (for example, Virtual Drumline, East/West,

and so on); these are played back through a virtual instrument. A virtual instru-

ment is a piece of software (called a plug-in) that produces sound on your com-

puter. In the past, MIDI keyboards, or MIDI sound generators, generated all of

the sounds we heard. Nowadays, sounds are living within the computer as plug-

ins. This requires that the computer itself generate the sounds that you hear, and

this is done through a virtual instrument.

Virtual instruments have one thing in common: They require a relatively fast

computer to run. The more instruments you run simultaneously, the more

Figure 1.5 The Playback Devices window.
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stressed your computer will become. Sibelius itself has no limit on the number of

sounds you can play back. The limit depends on the speed of your computer.

This is easily managed when you learn about the Mixer and its CPU utilization

display in Chapter 13, “Playback.” For a complete listing of Sibelius’s computer

requirements, check out www.sibelius.com/products/sibelius/features/require-

ments.html.

Fine-Tuning Your Audio Settings

Sibelius 6 also boasts a playback engine that integrates with built-in and external

soundcards (USB or FireWire). Go back to the Play menu and select Playback Devices.

On the resulting screen, click the Audio Engine Options button (see Figure 1.6).

To get the best possible performance from Sibelius, make sure you have a soundcard

that supports low latency. Latency is a measure of the time it takes for sound to become

audible as it runs through your computer system. For a program like Sibelius, which

allows you to enter notes along to a click track (called Flexi-time) input, high latency

can be a real challenge for accurate transcription. Because of this, Sibelius supports a

few different ways to interact with soundcards. On the Mac, audio is very straightfor-

ward: Every device that runs off OS X 10.4 or later needs to have a Core Audio driver

in order to run. Sibelius takes advantage of this, and if you’re a Mac user, you’ll see that

your choices are all Core Audio devices.

Figure 1.6 Audio Engine Options window.
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On a PC, there are three different drivers that Sibelius supports: ASIO, DirectSound,

and MME. ASIO will give you the lowest latency, and Sibelius will try to use an ASIO

device if it can. If it can’t find one, it will try a DirectSound device, followed by an

MME device. ASIO is the way to go, and you should see whether your built-in sound-

card supports ASIO for low-latency operation. In the unlikely event that it doesn’t sup-

port ASIO, there is a free third-party driver available at www.asio4all.com that will

allow most embedded soundcards to use ASIO and gain lower-latency options.

The Audio Engine Options screen provides you with the following options:

n Use Virtual Instruments and Effects. This allows you to turn off the use of

virtual instruments and effects. This could help if you have a very old computer,

and you just need a program to engrave music on (and you don’t care about

playback). But the vast majority of users will want this switched on.

n Interface. Here is where you can select the audio interface you want activated.

n Outputs. Sibelius uses only a stereo output. If your device has more than two

outputs, you’ll need to tell Sibelius which two outputs to use—it will default to

Outputs 1 and 2.

n Buffer Size. The buffer size (measured in samples) is in direct proportion to the

amount of latency on your system. A low buffer will result in low latency, but with

higher CPU taxation. Higher buffers will incur more latency but will allow your

CPU to do more (such as play back more instruments), so the magic number for

your buffer size will always vary, depending on what you’re doing. Use lower

buffers for Flexi-time and higher buffers for playback.

n Sample Rate. This is the frequency of the output audio and should remain at 44.1

unless you have a specific reason or need to change it (for example, when using

third-party samples that are sampled at 96 kHz).

n Latency. This window is not editable; it’s calculated by the sample rate and your

latency buffer. It shows you how long it will take (in milliseconds) from the time you

press a note on a MIDI keyboard until you actually hear it.

n Rescan. This rescans your computer for new VST and AU effects and instruments.

Use this only if you’ve added or removed plug-ins from your computer.

n ReWire. Sibelius now integrates with ReWire-enabled programs (Pro Tools, Logic,

SONAR, GarageBand, and so on). This option allows you to route the audio from

your Sibelius score into a digital audio workstation, such as Pro Tools. With this

capability, you can record an acoustic instrument or voice along with your Sibelius

score as it plays through your ReWire-enabled program. You can also combine

recordings created in your digital audio workstation (DAW) with your music cre-

ated in Sibelius. We will delve further into this feature in Chapter 12, “Playback and

Virtual Instruments.”
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Figure 1.7 shows some sample settings to get you started. The buffer has been set fairly

low to allow you to enter notes with lower latency.

You can always come back to this window and change the buffer size (which is gen-

erally the only thing you would change in this window) to balance between lower

latency for note input and higher latency to allow playback or more simultaneous vir-

tual instrument sounds.

Now that you have these vital settings configured, you can start using Sibelius.

Quick Start to a New Score

Remember that Quick Start dialog box that you dismissed earlier in order to set up

your program preferences? It’s time to bring it back and use it. You can get it back

in one of two ways. The first method is to quit the program, and the Quick Start will

come back up by itself. But you certainly don’t have to do that! The other way is to go

to the File menu and select Quick Start to reshow the dialog (see Figure 1.8).

We’re going to let the Quick Start dialog set up a new score for us, taking us through all

the various options for setting up a new score. This is a great place to start working

with Sibelius, because it will take you through some very important steps in a logical,

ordered way.

Figure 1.7 Sample audio engine settings.
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More Than One Way The Quick Start dialog box is just a collection of shortcuts

to various functions within Sibelius. We’re going to create a new score, which

can also be accomplished by simply selecting New from the File menu. The

Quick Start dialog box is just a portal to important functions that exist in the

menus at the top of Sibelius’s screen.

From the first Quick Start screen, select the Start a New Score radio button and then

click OK. Clicking OK takes you to the screen you see in Figure 1.9, where you’ll select

your manuscript paper, add additional instruments, and change your paper size and

orientation (if necessary).

Manuscript Paper

The Manuscript Paper screen contains premade groupings of instruments that come

with Sibelius. If you scroll through the long, distinguished list on the left side of the

window, you’ll see quite a few choices. Hopefully, the group of instruments you want

to write for will be available to you already. If not, no big deal—you can always add

instruments in a moment. Find the manuscript paper that is closest to the ensemble for

which you want to write.

Figure 1.8 The Quick Start dialog box.
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Custom Manuscript The manuscript papers that Sibelius ships with make up a

generous list to get you started. If you find that the ensembles you typically write

for aren’t showing up, and you have to add instruments each time, have no fear.

You can create your own manuscript papers that will show up in the list whenever

you create a score. We will cover that in Chapter 17, “Customizing Sibelius.”

For our purposes, select String Quartet from the Manuscript Paper list. You’ll notice

that as soon as you do so, you get a preview (a very small one) of the paper on the right

side of the window, as shown in Figure 1.10.

Adding Additional Instruments to Any Manuscript Paper

To show you how easy it is to add an additional instrument to any manuscript paper,

choose the Change Instruments button, directly below the list of available manuscript

papers on the left side. Figure 1.11 shows the Instruments dialog.

This dialog box shows you all of the selected instruments in your score (or manuscript

paper). The window is divided between the left side, where you can choose instruments;

the middle controls, when you can add, remove, or reorder instruments in your score;

and the right side, where the instruments in your score are organized.

To add instruments, first select from the broad category of instrument types at the top-

left of the screen, and then select the proper family of instruments directly below that.

To the right of those lists will be the final list of instruments. Once you’ve found and

highlighted the instrument you want, you can either double-click the instrument name

Figure 1.9 Start a new score.
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or click the Add to Score button to add the instrument to the score. When you’ve done

that, you’ll see that your instrument is now added to the Staves in Score list, with a

small þ next to its name. When Sibelius adds instruments to your score, it does so in

proper score order. You can also reorder the instruments using the Move Up or Move

Down button, which will move the currently selected instrument up or down.

Instruments

available

Controls for adding,

removing, and reordering

instruments

Currently added

staves in score

Figure 1.11 The Instruments dialog.

Figure 1.10 Manuscript preview.
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Add a flute to your string quartet by choosing Common Instruments > Woodwinds >

Flute and add it to your score. Figure 1.12 shows the result.

When you’re finished, you can select OK to get back to the Manuscript Paper screen.

Because you don’t necessarily need to change paper size or orientation yet, click Next

to progress to the next screen: House Style.

House Style

House Styles are Sibelius’s set of engraving rules for any particular score. House Styles

encompass the type of music font used, the staff margins, the appearance of bar num-

bers (or the lack thereof), and many other visual changes. In short, a House Style is the

look and feel of your score. Popular choices within the House Style are changes to

the musical font—the default Sibelius font (Opus), the plate engraved style (Helsinki),

the handwritten style (Inkpen), or the popular West Coast–styled font (Reprise).

Figure 1.13 shows the House Style window. You can also change the main text font

used in your score to any font installed on your computer system via the Main Text

Font drop-down menu.

Feel free to experiment with the House Styles to give your scores a different visual look.

For now, choose Unchanged as the default House Style for the selected manuscript

paper (based on the Opus font). It looks very good and is sufficient for learning.

Click Next to progress to the next screen in the score setup.

Time Signature and Tempo

The next screen in your score setup is the Time Signature and Tempo screen. From this

window, you can set up your initial time signature, define your beam and rest

Figure 1.12 Adding a flute.
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groupings, add a pick-up measure (anacrusis), add tempo text, and even add a metro-

nome marking! Figure 1.14 shows the Time Signature and Tempo screen.

Let’s start off with the time signature. The popular choices are listed for you, and if you

need to write an asymmetric or a special time signature, you can select Other and

choose your top and bottom values for the time signature.

If you have special requirements for how your beam and rests groups need to be set up,

you can access options via the Beam and Rest Groups button. The default should be

Figure 1.13 House Style choices.

Figure 1.14 Time Signature and Tempo options.
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fine, and we will come back to this at a later point in the book. If you absolutely know

you need to change it, go ahead and tweak it to your heart’s content—you can always

change it later!

Pick-up measures, or anacrusis bars, are easily set here. To add one, make sure the

check box next to Start with Bar of Length is selected. Doing so will allow you to

enter values into the drop-down box. The value of the pick-up bar always defaults

to a quarter note. To change this, click in the field that contains the quarter note. Either

you can backspace (or delete) to get rid of the quarter note or you can add notes to

equal the required length. There is a drop-down menu to the immediate right of the

quarter note (or the spot where it lived if you deleted it) that will expose note values.

Clicking on any note duration will add these together. For example, if you wanted a

dotted quarter note, you could start with the quarter note they provide and add an

eighth note or add the dot (.).

You can add tempo text to your score either by choosing one of the default Italian and

English texts or by creating your own in the dialog box.

To add a metronome mark, deselect the check box and choose your main pulse and the

number of beats per minute you’d like automatically added to the score.

It is always a good idea to add a metronome mark to your score even if you plan on

changing it later. When you do not add a tempo/metronome mark, Sibelius will default

to 100 beats per minute for playback.

Figure 1.15 shows a completed window for the score, which includes every feature of

the Time Signature and Tempo dialog box.

Figure 1.15 Completed Time Signature and Tempo dialog.
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Now that those important details are filled in, let’s progress to the next screen: Key

Signature.

Never Too Late During the setup of your score, you can always go back a

screen in the new score setup by clicking the Previous button. You can do

this only when you’re in the new score setup—once you’ve pressed Finish and

actually started your score, you will have to change elements of your score in

other ways.

Key Signature

The Key Signature dialog box shown in Figure 1.16 is a fairly easy screen to explain; it

lets you set the initial key signature for your score.

Select the desired signature by using the sharp signatures in the left column and the flat

signatures in the right column. The boxes for major keys and minor keys indeed make a

difference! When Sibelius takes MIDI input and has to decide which accidental to use,

it chooses the accidental based on which key signature was listed (choosing a C sharp

instead of a D flat in D minor, for example). If you’re not using MIDI input, don’t

worry too much about it—you can easily re-spell an accidental at any time. Once

you’ve selected the proper major or minor key signature, click the Next button to

take you to the Score Info page, the final screen in the new score setup.

Figure 1.16 The Key Signature dialog.
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Score Info

The final screen is the Score Info screen, which lets you add the following information

to your score:

n Title

n Composer/songwriter

n Lyricist

n Copyright information

n The ability to create a separate title page based on this information

n Other information about your score

This screen helps you fill out the most common text headings you’ll see on most scores.

As with any window in the new score setup, you don’t have to commit to anything

now. You can skip this altogether and add all the information later via Create > Text,

which I’ll detail as we get rolling.

When you’ve filled in the information for your score and decided whether you’d like

a title page, you’ll see that there’s no Next button to click, but now a Finish button. At

this point, you’re finished with the new score setup, and you’ll now be taken to

your newly created score. If all went as planned, you should be greeted by a completed

blank score in Sibelius in which you can start writing music. As your new score

loads, you’ll notice that the sounds for your new score will preload as the score

comes up. This will enable you to hear notes as you input them, and, of course, play

back when asked!

Figure 1.17 shows a newly created score.

Essential Tip: New Score Setup Just to remind you: Everything we set up in this

score can be easily changed at any point. The new score setup helps you auto-

mate the most commonly configured parts of your score. This is the basis of

Sibelius’s score setup, but you can do everything in the new score window

directly from any Sibelius score easily!

Now I’d like to take some time to go over the Sibelius interface so that you can under-

stand the functions of the visual user interface presented to you.

Interface Tutorial

Sibelius has the marketing catchphrase of “The fastest, smartest, easiest way to write

music.” I’ll go through its interface and show you that it is indeed easy to understand.

Figure 1.18 illustrates the major elements of the Sibelius interface.
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You can break the interface into the following three parts:

n Drop-down menus

n The toolbar

n Tool windows

Drop-Down Menus

Drop-down menus are a consistent visual feature in almost every software application

you can imagine. In Sibelius, the drop-down menus give you access to the plethora of

features and power within the program. Knowing your menus is a huge step to fully

understand a software program; Sibelius is no exception. Figure 1.19 shows the avail-

able drop-down menus in Sibelius.

Figure 1.17 A fully set-up score.

Figure 1.18 A guide to Sibelius’s interface.

Figure 1.19 Sibelius’s drop-down menus.
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Keyboard Access Learning the key commands to any software program will

make you a faster, more efficient user. To this end, I designed a keyboard

cover that slips right over your existing Mac keyboard. This cover provides direct

access to all the important key commands in Sibelius. The covers are inexpensive

and even protect your keyboard from dirt and wear and tear. If you want to

accelerate your learning process with Sibelius, pick one up today at www.

kbcovers.com. These covers are only available for Mac users due to the wide

variety of PC keyboard types and the few Mac ones. You can also purchase a

full keyboard from www.sibelius.com that will work on Mac or PC (via USB) and

that will replace your current keyboard.

Here are some basic descriptions of what each menu contains:

n Sibelius 6. On the Mac, home to your Preferences and window-based

controls.

n File. Anything to do with creating, saving, opening, printing, and exporting

files.

n Edit. Standard editing (cut, copy, and paste), along with music-specific editing, such

as hiding or showing elements, flipping stems, deleting bars, filtering music,

changing voices, and capturing ideas.

n View. The visual menu! Change the view from standard to panorama, show or hide

the rulers, color notes, and zoom.

n Notes. Input notes, Flexi-time record (record to a click), use automatic arrange

styles, and transpose music.

n Create. The central repository for basically anything you can do or add to a score

in Sibelius. It’s the most used menu in Sibelius, so they have provided an easy

shortcut: Right-click (Control-click on a Mac) to access the Create menu anywhere.

When you want to add something to your score, chances are that you can find

it here!

n Play. Everything that is related to the playback and video features with Sibelius.

This also includes the controls for Live Tempo, a new feature included in version 6

that will be discussed in Chapter 12.

n Layout. Your score’s document setup and layout controls. Tweak the appearance

and layout of your scores here.

n House Style. This controls how your score will print out; these features are also

commonly referred to as engraving rules. You’ll find elements such as the appear-

ance of text and musical fonts here.
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n Plug-Ins. These are extremely helpful automated “widgets” within Sibelius. There

are hundreds of plug-ins within Sibelius that will do a variety of things for you.

Plug-ins start with simple commands, such as checking for missing repeat bar lines

or unattached ties, and go as far as finding errors in your voice leading! There

are more than 100 additional free plug-ins for download at www.sibelius.com/

download/plugins.

n Window. Access to the many tool windows within Sibelius. These include your

keypad for entering notes, the Playback window, properties, and many more. If you

are working with multiple scores at the same time, the Window menu will show you

a list of your open scores so you can switch between them.

n Help. When you’re stuck, you can access the full 600-page Sibelius reference

and access other helpful guides and websites that relate to Sibelius. You can

also check for program updates and manage your Sibelius registration from

this menu.

The goal here was not to take every menu down and describe each entry—that would

be tedious and quite boring. Now that you have a general idea of what each menu does,

you’ll have a better chance at finding what you want at this early stage. As you get

going through the book and access all the commands within Sibelius, you’ll be calling

upon these menus quite often.

Essential Tip: The Create Menu As for the ease of use, check this out: I said that

the Create drop-down menu was very useful. I also said that all the elements of

the new score could be replicated easily within Sibelius. That’s right, you guessed

it—the Create menu provides access to key signatures, time signatures, instru-

ments, and text. (It also does more!) Consider it your central hub for creating

score elements in Sibelius 6.

The Toolbar

Directly below the drop-down menus is the toolbar, which is a collection of shortcut

buttons for various important tasks within Sibelius. Because the toolbar itself is quite

large and does so many things, for the sake of illustration, I’m going to break it into

two parts, starting with the left side of the toolbar, shown in Figure 1.20.

IG

F H J L N PDB

ECA K M O

Figure 1.20 Sibelius’s toolbar part one: the left side.
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Here is a breakdown of the functions that you can access from the left toolbar. Keep in

mind that this is just an illustrated overview. You don’t need to memorize or learn these

right now. As you progress through this book, these shortcuts, when applicable, will be

utilized in context.

n New. Create a new score.

n Open. Open a saved score.

n Scan. Scan music into Sibelius through PhotoScore.

n Save. Save your score to hard disk.

n Save Version. Save your score but do not replace the previous score.

n Export Audio. Render your score to an audio file, suitable for burning to a CD or

posting on a website.

n Print. Print your score.

n Redo. Redo the last action in Sibelius.

n Undo. Undo the last action in Sibelius.

n Edit Versions. Bring up and edit past versions of the score.

n Comments. Add comments/notes to the score.

n Zoom. Turn your pointer into a magnifying glass and click to zoom into or out of

your score.

n Zoom Box. Shows the current level of zoom in your score. You can click in the box

to enter a specific zoom percentage.

n Panorama. Changes from the default Score view to Panorama view, which lays out

your score on a single, never-ending page.

n Focus on Staves. This amazing button lets you select the staves you want to edit by

clicking on them, and it automatically hides the rest.

n Transposing Score. This allows you to toggle the view of your score from

transposing instrument view to concert pitch.

n Dynamic Parts. This drop-down menu lets you switch between the full score and an

individual part. (In Sibelius you never need to extract a part, because you can

always switch to a part from this menu.)

n Switch to Part/Score. This button takes you either from a full score to the

selected part (stave) or from a part window back to the full-score view.

Figure 1.21 shows the rest of Sibelius’s toolbar (the right side).
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n Help. Use Sibelius’s built-in help by accessing the full Sibelius reference in PDF

form.

n Navigator. Show or hide the onscreen score navigator.

n Keypad. Show or hide the Keypad view.

n Keyboard. Hide or show the onscreen piano used for input.

n Fretboard. Hide or show the onscreen guitar fretboard used for input.

n Playback. Hide or show the VCR-style playback controls.

n Mixer. Hide or show Sibelius’s virtual instrument and effect Mixer.

n Ideas. Show or hide the Ideas hub.

n Parts. Show or hide the Parts window. (These are not the Dynamic Parts; rather,

they are preferences and other controls for the parts that are created automatically

in your score.)

n Compare. Compare current scores to past versions.

n Video. Show or hide the Video window.

n Properties. Show or hide the Properties window. This window provides access to

myriad important onscreen properties that affect general aspects of Sibelius, text,

playback, lines, bars, and notes.

n Show/Hide. This button will show or hide the currently active tool windows. Active

tool windows will be shaded blue in the toolbar and, of course, appear on the

screen.

As you can see, the toolbar is chock full of important shortcuts and tools within Sibe-

lius. It contains visual links that you can find just by mousing around the interface.

Essential Tip: Tool Tips Sibelius will show you the function of any toolbar icon if

you simply hover your mouse over the button. Once you’ve dragged your

mouse over the icon or control, a small yellow box will emerge, telling you

what the control or button will do.

A C E G I K M

LJHFDB

Figure 1.21 Sibelius’s toolbar part two: the right side.
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The toolbar is very important, but you should try as hard as you can to learn the key-

board shortcuts whenever possible. It’s no surprise that everything on the toolbar can be

duplicated as a keyboard shortcut. Why would you want to use keyboard shortcuts

rather than just using your mouse? For starters, the mouse is simply very slow—

keyboard shortcuts are faster. Second, in Sibelius, you may want to use the mouse for

other things, so taking the cursor away from your current working area just to save your

file is inefficient when you could have simply pressed CtrlþS (PC) or CommandþS

(Mac) without having to move. The other benefit is that standard keyboard shortcuts

(Save, Open, Close, Print, Undo, Redo) are found in almost every program on your

computer! The most experienced computer users rely on keyboard shortcuts.

Onscreen Helpers (Tool Windows)

The toolbar showed you a collection of shortcuts. The last area of the toolbar is com-

posed of a larger group of windows called tool windows. When Sibelius starts, you will

see three of these windows by default. Because they are central to the functionality of

Sibelius, you’ll want to know as much as you can about them. Don’t worry; we’ll use

the rest of the tool windows when they’re needed—these three windows are just the

ones to start with.

The Navigator

The Navigator window, shown in Figure 1.22, usually resides at the bottom-left corner

of your screen (although you can move it wherever you need to).

The Navigator has the single job of allowing you to move your score around. It consists

of two parts. The first part is the Navigator itself, which shows a very small view of the

visible score. The exact amount of the score you can see in the Navigator depends

completely on your zoom level. You can show as few as one page or as many as 13

pages (at 12.5% zoom). The mini-score that it displays will never contain notes, only

bars and systems as an overview.

The second part is the white rectangle, which allows you to select what’s visible on the

Sibelius screen. You can do the following things with the Navigator:

n Click anywhere in the Navigator window, and the score will jump to the spot you

click!

n Drag the rectangle around to move the visible area of the screen.

Figure 1.22 The Navigator window.
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n If you drag the rectangle to the left or right edge, the score will navigate to the

pages you can’t currently see. As you drag the rectangle more to either side, the

score will scroll faster.

Lost your Navigator? Never had it in the first place? You can show the Navigator in

one of three ways. The first is by using keyboard shortcuts (which are mirrored in the

Window pull-down menu): CtrlþAltþN (PC) or CommandþOptionþN (Mac).

Panorama It’s worth mentioning that if you’re in Panorama view, you can’t

use or see the Navigator. You’ll also notice that the Navigator’s button is grayed

out in the toolbar. Instead, you should use the scroll bar at the bottom of the

screen.

You can drag the Navigator window itself by clicking on the title bar of the window

(where it says Navigator) and moving it to an inconspicuous spot in your score.

You can also show the Navigator by clicking on the Navigator button on the toolbar.

The Keypad

The Keypad is a central window in Sibelius. It provides access to note values, rests,

articulations, and a slew of other important commands. Rather than just being a win-

dow you can click to access, the aptly named Keypad window is a re-creation of the

keypad on your desktop computer’s keyboard. Figure 1.23 shows you the relationship

of the Keypad window to your computer’s keypad.

Figure 1.23 Keypad window legend.
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The Keypad window has six different views. The default view is the first keypad layout,

which takes care of basic note values, accidentals, and simple articulations. Figure 1.24

shows the first keypad layout.

The Keypad is an overview of your real keypad. In the first Keypad view, a whole note

is taken by the number 6, while a quarter note is taken by the number 4—these two

keys should center your brain for the rest of the keys. As you use these more, you’ll

memorize their locations. There are other keypads that you should look at, and you can

access them by clicking on the top row of the Keypad view, as shown in Figure 1.25.

Each keypad has specific features for specific tasks; you’ll want to check through each

one to see what lives where. From your computer’s keypad itself, you can change the

current Keypad view by pressing the þ key to go up a Keypad view and the – key to go

down a Keypad view. Sibelius 6 has added one more Keypad view for your conve-

nience. The fifth view allows you to enter jazz articulations, such as scoops, falls,

and so on. It also includes arpeggios and repeat bars (1, 2, and 4). There is a total

of six keypad layouts, and Figure 1.26 shows you all six.

You’ll spend the majority of your time using the first keypad. The others are definitely

useful, but you’ll call on them less often. The final visual aspect of the keypad is voice.

Sibelius allows you to enter notes in up to four different voices. Voices are used on

polyphonic music, piano music, and anytime you need more than one musical layer

Figure 1.24 First keypad layout.

Figure 1.25 Changing Keypad views.
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sharing the same stave (drum set notation). Across the bottom of the keypad is a selec-

tor for the four voices. Voice 1 is the default choice (of course). You can change voices

by clicking on the voice number you want, as shown in Figure 1.27.

Voices do all sorts of neat stuff that you’ll learn about as you proceed. One important

thing about voices is that each has its own color. There is blue for Voice 1 and green for

Voice 2. This helps you keep track of which note is in which voice as you navigate

through your score.

Laptop Users If you are on a laptop or are a user of a newer Mac desktop, look

down at your keyboard. Do you see a keypad? At first blush, no—you don’t

have a keypad, because most laptops try to shrink their overall size down as

much as possible for the sake of portability. The new Macs ship with slim alumi-

num keyboards that do not include the standard number pad. However, the

engineers did give you the functionality; it’s just hidden. If you stare at the J,

K, L keys, you’ll see a small 1, 2, 3 on each key, respectively (only on a laptop,

of course). You have a hidden keypad!

To access this keypad, you’ll have to press the Function, which is typically

shortened to FN, key on your keyboard. When you press the Function key, your

J key turns into a 1 on the keypad, and the rest of the keys that have dual

Figure 1.26 The complete keypad layouts.

Figure 1.27 Voice selection.
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personalities will follow suit. This enables you to access Sibelius’s keypad.

Unfortunately, it also cuts off a few other Sibelius shortcuts (most importantly,

the K shortcut for changing a key signature). So, what should you do? Either

plug in a full-size USB keyboard (they usually cost about $20) or get a USB

keypad, which, as you’d guess, fills in the missing keys on your laptop

keyboard. Several companies make plug-and-play USB keypads. If you’re going

to use Sibelius, you’ll want/need a proper keypad, so go to your local office

supply store and grab one.

If you are an iPhone or iPod Touch user, there is an app that emulates a number

pad. NumPad by Edovia Inc. transforms your iPhone into a number pad

wirelessly. It is compatible with Windows, Mac, and Linux.

Playback Controls

Playback controls, as shown in Figure 1.28, make up the last window shown by default

in Sibelius.

The Playback window is a sandwich of three layers. The first layer has the basic con-

trols. The basic controls act like a VCR or standard sequencer, allowing you to rewind,

fast-forward, and play your music. There are keys to move the playback to the start of

your score, move the playback to the end of your score, and even enter a real-time

recording mode, in which you can record from an external MIDI source. There are

other buttons that we’ll get into in our playback chapter (Chapter 14). For now, you

can start and stop your score whenever you need to. A couple of useful keyboard short-

cuts include:

n P: Start playback from the currently selected note

n Spacebar: Stop or start playback from the currently selected point/note

n [: Rewind

n ]: Fast-forward

If you rewind or fast-forward while playback is engaged, you’ll hear the music while

you scrub around the score. The longer you hold down fast-forward or rewind, the

faster those functions work.

Figure 1.28 The Playback window.
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The middle layer is a playback bar, which follows the playback head as it goes. It’s laid

out from left to right, and you can think of it like the needle of a record player. You can

“drag” the slider to the middle of its range, and it will play back exactly from the

middle of your score. It’s very handy for starting playback from general spots in the

score.

The bottom layer shows the time readout of your score. It displays where you are in the

score in the following format: hours:minutes’seconds.milliseconds. It displays these

exact timings because Sibelius can synchronize to video, and it’s also useful to know

how long your piece may be when played. To the right of that are the bar and beat

displays that read out where you are during playback. (When playback is stopped, this

shows the location of the playback head so that when you press the spacebar, you’ll

know where to play back from.) There is also the current metronome mark or tempo of

your piece. There is even a tempo slider here for changing the playback tempo (either

while playing or while stopped).

Amazingly enough, that’s all you need to understand to get going. It’s time to start your

first score and learn how to get notes from your creative mind into Sibelius.
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